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LESSON 0
SETTING UP HARDWARE 

& SOFTWARE



Part 1: Put Up Label Stickers for Pin Headers

1. Remove the Maker UNO from the packaging and you will �nd a set 
     of label sticker.

2. Peel o� the stickers and attach them on the pin headers
     accordingly. 

| 



3. Connect Maker UNO to your PC with a micro USB cable.

1. Log on to https://www.arduino.cc/en/main/software. 

|

Part 2: Download & Install Arduino IDE

2. Choose your OS to proceed. 

For Windows users, it is 
recomeded to select this �le. 



3. Arduino IDE is an open source software that allows you to 
    download and use it for free. 

| 

4. Double click on the downloaded �le to proceed. 

For  Window For  Mac

5. Once installation is completed, the Arduino’s icon will appear.
    Double click the icon to launch the Arduino IDE. 

However, you are encouraged to make a monetary contribution 
to help them to continue to fund their development. 
Anyway, you are free to click  “JUST DOWNLOAD”.



|

          
             

           

 

Basic Electronics

Output devices: LED, LCD screen, buzzer, speaker, motor, etc. 

Part 3: Download & Install Driver

For Window Users: 

1. Download the driver here: 
    https://cdn.cytron.io/makeruno/CH341SER.EXE 

2. Double click the “CH341SER” �le to begin installation. 

3. Click “INSTALL”. 

4. Click “OK”. 



          
             

           

 

5. Go to window search, seaarch for “device manager”. 

6. Click       to expand “Ports (COM & LPT)”. Check which port the CH340
    driver is being assigned to. Remember the com number. (For this 
    example, the com number is com 5)  



          
             

           

 

7. Launch Arduino IDE. Select the right com port. Tools >Ports >COM X 
(Make sure your Maker UNO is connected to your PC) 

For Mac users: 

3. Click “Continue” to begin installation. 

1. Download the driver here: 
    https://cdn.cytron.io/makeruno/CH341SER_MAC.ZIP 

2. Double click the zip �le, open the unzip folder then double click the
     pkg �le. 



          
             

           

 

4. Once done, click “Restart” to restart your Mac. 

Note: if you are unable to locate /dev/cu.wchusbseial1410, please follow the 
troubleshooting steps: 
https://cdn.cytron.io/makeruno/Troubleshooting_CH431_Driver_For_Mac.pdf. 

5. After you have restarted your Mac, launch Arduino IDE again. 
     Choose the driver in Tools > Port > /dev/cu.wchusbserial1410 

Congratulation! You have successfully setup Maker
UNO and we will start making something in the next 
lesson.



LESSON 1
DIGITAL OUTPUT



Project 1: Turn On An LED

1. Connect your Maker UNO with your PC with a USB cable.

2. Launch Arduino IDE. 



3. Write these code into your sketch.

4. Click compile      , wait for a few seconds until you see “Done 
    Compiling” appear at the bottom of the sketch. 

1. If error occurs, go through your code line by line  to make sure they are 
    correct and then compile again.

   2. Don’t mixed up the normal backet ( ) and the curly bracket { }. 

Troubleshooting 



6. Check your result. 

5. Then click upload         . Wait for a few seconds and you will see 
    “Done Uploading” appear at the bottom of the sketch.

You will see LED 7 is on 
while the rest of the LEDs 
are o�.

Troubleshooting 

1. If error occurs,  please ensure that your Maker UNO is connected to your PC
and select the correct port at Arduino IDE again. “Tools > Port”



Arduino Function
1. To set a pin as input or output:

          pinMode(pin, mode);
             pin: the number of the pin whose mode you wish to set

mode: INPUT, OUTPUT or INPUT_PULLUP

           
digitalWrite(pin, value);
pin: the pin number
value : HIGH or LOW

value: HIGH or LOW

 

Good To Know

How it works

2. To turn a digital pin HIGH (on) or LOW (o�):

First of all, tell the board to set Pin 7 as output.

You ask the board to turn Pin 7 to high (on).

Basic Electronics
Input Devices: Switch, sensor, microphone, potentiometer, etc.

Output devices: LED, LCD screen, buzzer, speaker, motor, etc. 



https://youtu.be/GU5UpkuH_DU

Project 2: Blink An LED

1. Modify your previous codes into this.

2. Click compile        , wait for a few seconds until you see “Done
     Compiling” appear at the bottom of the sketch. 

3. Then click upload        . Wait for a few seconds and you will see 
    “Done uploading” appear at the bottom of the sketch. 

4. Check your result.

LED 7 will be blinking 
while the rest of the 
LEDs are o�.



5. Change the delay value to 1000 then upload it to your board again.

6. Observe the result and compare with the previous program. Can 
        you tell the di�erence? 

How it works

First of all, tell the board to set Pin 7 as output.

LED 7 is on
Hold for 1000ms
LED 7 is o�
Hold for 1000ms
.

The program 
will continue 

to loop 
endlessly. 



Good To Know

Arduino Function
1. To pause or hold the program:

delay(ms);
ms: the number of miliseconds to pause



Project 3: Blink the LEDs in Sequence

1. Modify your previous code into this.

In this project, we want to blink LED 2, LED 3, LED 4, LED 5, LED 6 
and LED 7 in sequence.

2. Click compile        and then upload         .



https://youtu.be/tiYixUo2MP4

3. Check your result.

LED 2- LED 7 go on and o� together
which is not the consequence
that we want. Why?

How it works

Set Pin2 - Pin 7 as output.

The program will turn on LED 2- LED 7 all at 
the same time.

Hold for 1000ms.

The program will turn o� LED 2- LED 7 all at 
the same time.

Hold for 1000ms.

Click here or scan QR code to 
watch the demo video



4. Modify your previous code into this.



https://youtu.be/8ykIuFa5DMc

Arduino Function
1. To set a pin as input or output:

          
             pin: the number of the pin whose mode you wish to set

mode: INPUT, OUTPUT or INPUT_PULLUP

           
digitalWrite(pin, value);
pin: the pin number
value: HIGH or LOW

 

Good To Know

First of all, tell the board to set Pin 7 as output.

Basic Electronics
Input Devices: Switch, sensor, microphone, potentialmeter, etc.

Output devices: LED, LCD screen, buzzer, speaker, motor, etc. 

5. Check your result.

The LED will go on one by one then
o� one by one.

The program runs line by line super 
fast (in less than 1 micro second) 
until all lines are executed almost 
at the same time. That’s why you 
will see all LEDs go on or o� at the 
same time.

To �x that problem, we need to 
add a delay in between each LED.

Click here or scan QR code to 
watch the demo video



https://youtu.be/R5Eeh8yn9AA

https://youtu.be/R5Eeh8yn9AA

          
             

           

pin: the pin number
value: HIGH or LOW

 

Q: Program LED 2 - LED 13 to execute the blinking pattern as shown
at the demo video below.

Congratulation! You have completed lesson 1and 
learnt the following:

1. How to set pin as digital output.
2. How to on and o� a digital output pin.
3. How to use delay function.

Challenge

Click here or scan QR code to 
watch the demo video



LESSON 2
DIGITAL INPUT



https://youtu.be/AihIuY4cX6Q

Project 4: On-Board Push Button Switch

1. Open a new sketch then write these codes into the sketch.

In this project, we want to control an LED using the on-board
push button switch.

2. Compile and upload the program.

3. Check your result.



   2. Don’t mixed up the normal backet ( ) and the curly bracket { }. 

How it works

Set Pin2 - Pin 7 as output.

The program will turn o� LED 2- LED 7 all at 
the same time.

Hold for 1000ms.

Good To Know

Arduino Function
1. To use the on-board push button switch, we need to set it as 
“internal pullup input”.

pinMode(2, INPUT_PULLUP);

2. The on-board LED at Pin 2 will act as an input indicator.
It will turn o�  if  the on-board switch is pressed.

3. The on-board switch is internally connected to Pin 2. Meaning it is 
occupied and cannot be connected to any other external components 
anymore if you would like to use it.

Set Pin 4 as output.
Set Pin 2 as on-board switch input.

Read Pin 2. If it is low (switch is pressed)
Set Pin 4 to high.

Else. (switch is not pressed)
Set Pin 4 to low.



Coding Syntax
1. To use “if-else” statement.

if (condition 1)
{
// do thing A
}
else if (condition 2)
{
// do thing B
}
else
{
// do thing C
}

2. We can put a sign shown below, if you want to leave a reminder or
    comment for yourself while programming. Anything written behind
    this sign will be ignored by the program and will not be executed.

// your own comments here



Project 5: External Push Button Switch

1. Get these components.

In this project, we want to construct a basic circuit of an external 
push button switch.

2. Construct the circuit as shown below.

Breadboard Push Button Switch 

Jumper Wire 10K ohm resistor 



   2. Don’t mixed up the normal backet ( ) and the curly bracket { }. 

Set Pin2 - Pin 7 as output.

The program will turn o� LED 2- LED 7 all at 
the same time.

Hold for 1000ms.

Set Pin 2 as on-board switch input.

3. Press the external push button switch. Observe LED 3, it is on before
     you press the switch and goes o� when the switch is pressed. If it is
     not working, please �x your circuit before you proceed to the next
     step.

4. Modify your previous code into this, then upload to your board.



5. Check your result.

When the external push button switch is
pressed, LED 4 will be on.

How it works

Set Pin 4 as output.
Set Pin 3 as input.

Read Pin 3. If it is low (switch is pressed)
Set Pin 4 to high.

Else. (switch is not pressed)
Set Pin 4 to low.

https://youtu.be/zGL2JeZqzAE



          
             

           

 

Good To Know

Arduino Function
1. Switch is an input, you need to set that pin as input before you can 
    use it.

pinMode(pin, INPUT);

Basic Electronics

1. Breadboard internal connectivity.

2. For any digital input, you can make it as “pull-up” or “pull-down”
     circuit.

Arduino

10K ohm

Arduino

10K ohm

Pull-up resistor Pull-down resistor

VS

It is HIGH when the 
switch is not pressed

It is LOW when the 
switch is not pressed

In this project, we are using “pull-up” circuit but both are OK to use. 



https://youtu.be/vUW8IL47HnM

          
             

           

pin: the pin number
value: HIGH or LOW

 

Q: Use both on-board and external switches. When both switches are
     not pressed, both LED 4 and LED 5 will be on. If the on-board 
     switch is pressed, LED 4 goes o�. If external switch is pressed, LED 5
     would go o�.

Congratulation! You have completed lesson 2 and 
learnt the following:

1. How to read the digital input signal.
2. How to control an LED using a switch.
3. How to construct a simple pull up/ pull down circuit.
4. How to use if else statement.

Challenge

Click here or scan QR code to 
watch the demo video



LESSON 3
ANALOG OUTPUT



Project 6: Construct An LED Circuit

|

1. Get read these components.

2. Construct the circuit as shown below.

Breadboard Jumper Wire 

LED 

220 ohm resistor 

long leg

short leg



https://youtu.be/-qxAihgYSFA

| 

3. Upload these codes to your board.

5. Check your result.

Both on-board LED and the external LED at Pin 5 will blink
after the on-board switch is pressed. Nothing can stop the 

program unless the reset button is pressed.

Click here or scan QR code to 
watch the demo video



|

Basic Electronics

How it works

Set Pin 2 as pull-up input
Set Pin 5 as output

The blinking program will start running if the
switch is pressed.

This code is to ensure the program will continue
to run once the switch is pressed for the �rst time
and it will not stop unless we reset the program.

If the switch is not pressed, LED 5 
will always turn o�.

Good To Know

1. Light emitting diode (LED) has 2 pins, 
you need to connect it to the correct 
polarity, the long leg to the + and the
short leg (�at edge at the body) to the - .
Otherwise it will not work.



| 

2. Resistor doesn’t has + and - terminal,
you can connect the pins anyway you
like..

3. The color bands on a resistor can tell
about its value. Please refer to the chart
beside to undertand how to read them.  

Coding Syntax
A while loop will loop continuously, and in�nitely, until the condition
inside the parenthesis, ( ) becomes false.

while (condition)
{
// statements
}

Example:
1. Do something for 200 times
        
        var = 0;
        while (var < 200)
        {
          //do something
          var ++;
         }

2. Do something endlessly

        while (1)
        {
        // do something
        }

example: 470      5%+-

2nd digit multiplier tolerance1st digit

0 0
10

100

1k

10 k

100 k

1 M

10 M

1
1
2
3
4
5
6
7
8
9

1
2
3
4
5
6
7
8
9

1% brown

2%red



https://youtu.be/0ExJ5gWEp6c

Project 7: Fade An LED

1. Remain the same circuit used in Project 6, upload these codes to 
your board.

2. Check your result.

You will notice that the LED’s
brightness is reduced gradually
until it is completely o�.

Click here or scan QR code to 
watch the demo video



How it works

Set LED 5’s brightness to 60.
hold for 200ms.
Set LED 5’s brightness to 55.
hold for 200ms.
Set LED 5’s brightness to 50.
hold for 200ms.
Set LED 5’s brightness to 45.
hold for 200ms.
Set LED 5’s brightness to 40.
hold for 200ms.
Set LED 5’s brightness to 35.
hold for 200ms.
Set LED 5’s brightness to 30.
hold for 200ms.
Set LED 5’s brightness to 25.
hold for 200ms.
Set LED 5’s brightness to 20.
hold for 200ms.
Set LED 5’s brightness to 15.
hold for 200ms.
Set LED 5’s brightness to 10.
hold for 200ms.
Set LED 5’s brightness to 5.
hold for 200ms.
Set LED 5’s brightness to 0 (o� the LED).
hold for 1000ms.

Set Pin 5 as output



3. We have an easier way to simplify the codes above. Modify your 
code into this then upload to your board:

4. Check your result. It should be exactly the same as the earlier result.

https://youtu.be/0ExJ5gWEp6c



          
             

           

value: HIGH or LOW

First of all, tell the board to set Pin 7 as output.

Basic Electronics

Coding Syntax

How it works

De�ne a variable. Put an initial value
into that variable.

Set Pin 5 as output.

We need to reduce the brightness 
value by 5 every 200ms until the LED
is o� (brightness = 0).
When it is 0, delay for 1s then assign 
brighness to value 60 again so that 
the program will keep looping.

Good To Know

Arduino Function
1. There are 2 types of outputs, digital and analog. Digital means 0 (LOW)
    or 1 (HIGH). Analog means variable from 0 to 255. You can use the 
    following function to control the analog output.

analogWrite(pin, value);

At the beginning of the program, LED’s
brightness is equal to the initial de�ned
value which is 60. We need to reduce 
the brightness value by 5 every 200ms 
until the LED is o� (brightness = 0).
When it is 0, delay for 1s then assign 
brighness to value 60 again so that 
the program will keep looping.



          
             

           

pin: the pin number
value: HIGH or LOW

 

Congratulation! You have completed lesson 1and 
learnt the following:

2. However, not every pin on the 
    board has analog output. Only 
    Pin 3, 5, 6, 9, 10 and 11 has 
    analog output. 
    (the pin with ~ sign)

x == y (x is equal to y)
x ! = y (x is not equal to y)
x < y (x is less than y)
x > y (x is greater than y)
x < = y (x is less than or equal to y)
x > = y (x is greater than or equal to y)

Coding Syntax
1. The beauty of coding is allowing the programmer to simplify a very 
    long instruction into a few lines of codes that executes same task.
2. Reducing the number of lines also helps to reduce the processing time,
     thus it is very important to always optimize your code.
3. In this project, we need to reduce the LED brightness every 200ms. So
    we de�ne it as an integer variable at the beginning of our program. 
    “brightness” is just a variable name, you can name it as A or B if you 
     want.
4. These are the comparison commands you can use in coding.   



https://youtu.be/JZoGsz2HBBg

Challenge

          
             

           

pin: the pin number
value: HIGH or LOW

 

Congratulation! You have completed lesson 1and 
learnt the following:

Q: Fade the LED 5 only when the on-board switch is pressed .

Congratulation! You have completed lesson 3 and 
learnt the following:

1. Construct a basic LED circuit.
2. How to use while loop.
3. The di�erence between digital output and analog output.
4. The importance of reducing the number of lines of codes.

Click here or scan QR code to 
watch the demo video



LESSON 4
MELODY TONE



https://youtu.be/06gkCGmzPaA

Project 8: Compose Basic Tones

1. Open a new sketch, write these codes into the sketch then upload
    to your board.

2. Check your result.

You should be able to hear the 
basic tone of “Do Re Mi Fa So
La Ti”.



How it works

Set Pin 8 as output

Get piezo buzzer to play “Do”  (C4) for 1 beat.
Add delay until the note is completed.
Get piezo buzzer to play “Re”  (D4) for 1 beat.
Add delay until the note is completed.
Get piezo buzzer to play “Me”  (E4) for 1 beat.
Add delay until the note is completed.
Get piezo buzzer to play “Fa”  (F4) for 1 beat.
Add delay until the note is completed.
Get piezo buzzer to play “So”  (G4) for 1 beat.
Add delay until the note is completed.
Get piezo buzzer to play “La”  (A4) for 1 beat.
Add delay until the note is completed.
Get piezo buzzer to play “Ti”  (B4) for 1 beat.
Delay for 1s.



Good To Know

Maker UNO’s Feature
1. The on-board piezo buzzer is connected to Pin 8.  You need to switch 
it to the        sign if you want use the piezo buzzer. When you connect it 
with other I/O, you need to switch it to 

Arduino Function
1. To play a tone from the piezo buzzer.

tone(pin, frequency, duration);
pin: The pin that connected with a piezo buzzer
frequency: the frequency of the tone in hertz
duration: the duration of the tone in miliseconds (whether it is 
1 beat, 2 beats or etc.)

2. There is always a delay after tone. The delay has to drag 30% longer 
    than the tone duration to ensure the tone is completed. 

e.g.: The tone duration for 1 beat is 250ms, thus we need to allow
         a 325ms delay. 



Music Sheet

1. The position of a music note on the sta� (i.e. the �ve horizontal lines)
    determines its pitch (the frequency of the piezo buzzer). The higher 
    the note sits on the sta�, the higher the pitch of the sound and vice 
    versa.    

2. The di�erent musical notations used to tell us the duration a note is to 
     be played. In Arduino, the duration to play quarter note (1 beat) is 
     250ms.    

Note
Frequency

C  D  E  F  G  A  B  C  D  E  F  G4  4  4  4  4  4  4  5  5  5  5  5

�� � � � ������� � � � ������� � � � � � � �� � � � � � � � �� � � � � � ������ � � � � � � � � � � � � � � � � � � �� � � � � �  � �

 1000ms

500ms

250ms

125ms

63ms 

4 beats

2 beats

1 beat

1/2 beat

1/4 beat

Whole Note

Half Note

Quarter Note

Eight Note

Sixteenth Note

Semibreve

Minim

Crotchet

Quaver

Semiquaver

 262   294     330    349    392    440     494    523    587     659    698     784  



Project 9: Compose “Happy Birthday” Melody

1. Modify your previous code into this then upload to your board.

Compose the �rst line of the “Happy Birthday To You” song.

Note  

Frequency 

Duration          

G4 A4 G4 C5 B4G4

125ms   125ms    250ms    250ms    250ms    500ms

392        392        440         392        523       494



https://youtu.be/zWtIGIzGBYk

   2. Don’t mixed up the normal backet ( ) and the curly bracket { }. 

The program will turn o� LED 2- LED 7 all at 
the same time.

Hold for 1000ms.

2. Check your result.

How it works

Get piezo buzzer to play G4 for 1/2 beat.
Add delay until the note is completed.
Get piezo buzzer to play G4 for 1/2 beat.
Add delay until the note is completed.
Get piezo buzzer to play  A4 for 1 beat.
Add delay until the note is completed.
Get piezo buzzer to play G4 for 1 beat.
Add delay until the note is completed.
Get piezo buzzer to play C5 for 1 beat.
Add delay until the note is completed.
Get piezo buzzer to play B4 for 2 beats.
Delay for 1s.

Set Pin 8 as output

Click here or scan QR code to 
watch the demo video



Project 10: Optimize Your Code

1. Open a sample code. File > Examples > 02 Digital > toneMelody

Instead of manually key in the tones’ frequency and duration line 
by line, we can optimize it using a given sample code to shorten
our prvious code. This allows us to compose a long melody
e�ortlessly.

2. From the example given. Every note’s frquency is prede�ned from
     note B0 until DS8. What we need to do is to key in the notes we
     want and the note duration in seqence.



3. Refer to the same music sheet again then key in the note and note
     duration accordingly. 

You can click the “pitches.h” tab to view the prede�ned notes’
frequency. 

The program will turn o� LED 2- LED 7 all at 
the same time.

Note    

Frequency

Duration
Eighth

note (8)
Eighth

note (8)
Quarter
note (4)

Quarter
note (4)

Half
note (2)

Quarter
note (4)

125ms   125ms      250ms     250ms     250ms     500ms

392     392           440          392         523            494

G4     G4       A4         G4            C5              B4



4. Check your result.

You are supposed to get the same result as Project 9’s.



          
             

           

value: HIGH or LOW

How it works

Insert the notes to be played in sequence.

We are using a for loop here. 6 means 
there are 6 notes to be played in this 
program.

Insert the notes’ duration in sequence.

1000 divided by noteDuration
is to get duration in miliseconds. 
e.g. 1000/ 8 = 125ms 

This is exactly what we wrote previously.
tone (8, frequency, duration); 

delay (duration + 30%); 



Good To Know

 

2. To use “for” statement.

Coding Syntax

1. Did you notice that the melody only play once and it doesn’t repeat
     like the previous programs? 
     
     This is because the entire code is written under void setup() instead 
     of void loop (). You can only repeat it if you reset the program (by 
     pressing the reset button) .

for(initialization; condition; increment) 
{
 // statement(s)
}

Example:

{
analogWrite (PWMpin, 1);
delay (10);
analogWrite (PWMpin, 2);
delay (10);
analogWrite (PWMpin, 3);
delay (10);
analogWrite (PWMpin, 4);
delay (10);
}

The above codes can be shorten into 3 lines using “for” statement
shown below:

for (int i=0; i <= 4; i++) 
{
       analogWrite (PWMpin, i);
       delay (10)
}



https://youtu.be/eLDuf_5Jz9g

          
             

           

pin: the pin number
value: HIGH or LOW

 

Coding SyntaxQ: Program Maker UNO to play a complete “Happy Birthday to you” 
     melody when the on-board switch is pressed.

Challenge

Congratulation! You have completed lesson 4 and 
learnt the following:

1. How to program a tone from Maker UNO.
2. How to compose a simple melody using Maker UNO.
3. How to load Arduino’s sample program.
4. How to use for statement.

Click here or scan QR code to 
watch the demo video



LESSON 5
ANALOG INPUT



Project 11: Display Analog Value on Serial Monitor

1. Get ready these components 

2. Construct the circuit as shown below.

breadboardjumper wires Potentiometer



4. Once done uploading, click         (serial monitor) located at the right
     top bar. Immediately, you will see a pop up window appear.

3. Write these codes then upload to your board. 



https://youtu.be/URTHOm1m674

5. Turn the potentiometer clockwise and counter clockwise and you 
     will �nd the value displayed on the serial monitor changes as you 
     adjust the potentiometer. The display values are analog value 
     provided by the potentiometer. 

6. Check your result.



          
             

           

Good To Know

Arduino Function

1. Only pin A0, A1, A2, A3, A4 and A5 have analog input function. Hence
     we need to connect the analog sensors to these pins if we need analog
     input values.

2. Digital input only has 2 values, either 0 (low) or 1 (high). However in 
     analog input we can have variable from 0 to 1023.

How it works

Read the analog values from Pin A0
 and display them at serial monitor.

Setup serial communication



Project 12: Read Analog IR Sensor

1. Get ready these components. 

BreadboardJumper wires IR sensor

2. Construct the circuit as shown below.



4. Click the serial monitor to observe the analog input’s value. Move 
     your palm closer to the IR sensor to see the changes of the analog
     value.

3. Upload the same program used in Project 11 to your board. 



https://youtu.be/I5Ra1xtBMIU

5. Check your result.

Infrared (IR) sensor consisted of an IR transmitter and IR receiver. The
transmitter will transmit infrared light when power up. If there is an object
placed infront of the sensor, the IR light will be re�ected and received by
the IR receiver. The distance between the object and IR sensor will change
the intensity of the IR light received by the receiver. The intensity will then
be converted into analog value that you will be observed in the serial 
monitor. When the intensity is high, the analog value that we receive will 
be low.    

How it works

If the distance of the object is far, the
intensity of the IR is low, the analog 
value is high.

If the distance of the object is close, the
intensity of the IR is high, the analog 
value is low.



Project 13: IR Sensor To Detect Black Line

1. Get ready a piece of white cardboard and black marker. 

2. Fold the cardboard as shown below:

10cm 

7cm

3cm

8cm



4. Fixed the distance between the cardboad and the IR sensor at
     approximately 2cm. Move the cardboard horizontally from the 
     white surface to the black line.

3. Draw a black line with 2cm thickness in the middle of the cardboard
     using the black marker. 

2cm

2cm



5. Observe and record the analog values from the serial monitor when
     the IR sensor is facing the white surface and black line respectively.

White surface

Black line

Analog Value

6. Write these codes into a new sketch and then upload to your board.

Note: IRvalue > 500 is the threshold for my case. You can change the 
value according to the analog values shown in your serial monitor. 
You can pick any value between the white surface and black line.



https://youtu.be/bMlAJzzerqc

          
             

           

value: HIGH or LOW

7. Check your result.

How it works

LED 3 will light up when the black
line is detected and it will go o� 
when the white surface is 
detected.

De�ne a variable name as “IRvalue”

Display the analog input for Pin A0 at 
serial monitor.

Assign the analog value at Pin A0 to IRvalue

Setup serial communication

Set Pin 3 as output

If IRvalue > 500 (means black line is detected)
on the LED 3

Else, o� the LED 3

Click here or scan QR code to 
watch the demo video



Besides detecting object and measuring distance, the IR sensor also can be
used to di�erentiate black and white surfaces. This is because the light 
surface is able to re�ect most of the IR light while dark surface tends to 
absorb the IR light. Hence the IR receiver will receive less IR light when it 
faces the dark surface.   

Good To Know

This concept allows the IR sensor to be used at the mobile robots to
follow lines.

dark surfaces absorb more
IR light than light surfaces



https://youtu.be/iOT__6hnxvw

Coding Syntax
In this project, the analog value from the IR sensor is changed based on
the color of the object. We need to store the variable number to a certain
place and only summon it when needed. To do that, we can assign a
variable.

int var = val;      or     int var; 
var: your variable name (can be IRvalue or A or B or anything 
you like)
val: the value you assign to the variable (can be any number 
from -32,768 to 32,767)

Challenge

Q: Utilise the analog values from a potentiometer to change the
      blinking speed for LED 3.

Congratulation! You have completed lesson 5 and 
learnt the following:

1. How to read analog input.
2. How to use serial monitor.
3. What is IR sensor and how it works.
4. How to assign variable numbers



LESSON 6
DC MOTOR



Project 14: Control A DC Motor

1. Get ready these components 

Breadboard Jumper wires

DC motor

Diode

220 ohm resistor 

2N2222 Transistor

The terminal with a white 
stripe should connect to 
the positive wire (red)



2. Construct the circuit as shown below.

3. Write these codes then upload to your board. 

3

1



https://youtu.be/yjGUzMH8890

4. Hold the DC motor then press the on-board pushbutton switch. 

5. Check your result.

Click here or scan QR code to 
watch the demo video



          
             

           

1. Make sure you are holding the DC motor, the motor may not have 
    su�cuient torque to spin if the blade is attached on the table.
2. Also check the on-board LED at Pin 5. It should turn on in full brightness 
    for 3s then dim for another 3s.
3. If everything is correct then you have to check your circuit board. Are all
     components connected correctly?

How it works

Setup serial communication

Troubleshooting 

Set Pin 5 to run at full speed (255)
Delay for 3s
Set Pin 5 to run at low speed (80)
Delay for 3s



Good To Know

How To Control A Motor Speed?
To make a DC motor to spin, simply apply suitable input voltage on it. The
input voltage is recommended by the motor manufacturer. The typical 
input voltage for DC motors are 3V, 6V and 12V. However, the motors still
able to work even if you apply lesser or greater voltage than the 
recommended voltage. For the toy motor that we are using in this project, 
the recommded voltage is 3V, but we will try to apply 3.3V and 5V on it.
Let’s see what will happen.    

Connect the red wire to 3.3V 
pin. The motor spins slower

Connect the red wire to 5V 
pin. The motor spins faster

This test shows that the input voltage can change the speed of a DC 
motor. That’s why in the earlier program, when we apply lower PWM value,
the motor spins slower. But please take note that applying greater than 
the factory recommeded voltage to a motor for long run is not a good idea. 
It will shorten the motor’s life cycle.



How To Control A Motor’s Spinning Direction?
To change the spinning direction is easy. Simply change the positive and
negative supply to the motor terminals.
  

Red wire to 5V, black wire to the
ground. The motor spins in 1 
direction.

Black wire to 5V, red wire to the
ground. The motor spins in 
another direction.

We are unable to change the motor spinning direction with the circuit we 
built earlier. The easier way to achieve that is to get a DC motor driver that 
able to control both speed and direction. You can either build it yourself or
buy a ready made motor driver from the market.  If you want to learn more 
about controlling a DC motor, you can refer to this tutorial: 
https://tutorial.cytron.io/2018/08/02/5-easiest-ways-to-control-a-dc-motor/ 

Sample of DC Motor drivers available in the market.



https://youtu.be/2Ks-zsne-0o

Project 15: Controlling Motor Speed Using A Pushbutton

1. Write these codes then upload to your board. 

2. Check your result.

Click here or scan QR code to 
watch the demo video



How it works

De�ne a variable name  “mode”,  set the
initial value as  0.

if mode  =  0,  motor runs at speed 0 
(stop)

if mode = 1, motor runs at speed 100 
(slow)

if switch2 is pressed, 
check switch2 again until it is released.
then mode  value + 1
If mode value = 3, mode value set to 0

if mode = 2, motor runs at speed 255 
(full speed)

if mode is neither 0, 1 or 2, set mode
to 0

When the switch is pressed for the 1st time,  mode = 1, motor will run at 100.
When the switch is pressed for the 2nd time, mode becomes 2, motor will run
at full speed. 
When the switch is pressed for the 3rd time, mode value will be reset to 0 again.
The motor will stop.



Good To Know

Coding Syntax
1. Like if statemets, switch..case controls the �ow of programs by allowing
programmers to specify di�erent code that should be executed in various 
conditions. This is useful when you want to use 1 switch to execute 
di�erent set of program.

Example code
switch (var)
{
    case 1:
    // do something when var =1
    breaks;

    case 2:
    //do something when var = 2
    breaks;

    default:
    //if nothing else matches, do something
    breaks;
} 

2. Did you notice we didn’t put “ ; ” after while (1) at our previous projects 
but we put “ ; ” after while(digitalRead(2)==LOW) in this project? 

without “ ; ”
while (condition)
{
// if the condition is 
true, program will 
run all codes inside {  }
}

with “ ; ”
while (condition);  // if the condition is true,
it will only run this line

e.g.: 
while (digitalRead(2) == LOW); 

if switch 2 is pressed (condition is true), the 
program will stay there until switched 2 is 
released (condition false).



https://youtu.be/I2Qj1b2O5VU

          
             

           

Challenge

Q: The motor will run at a constant speed when you press and hold the 
      pushbutton. It will stop when you release the button. When you press 
      the pushbutton for the second time, the motor’s speed will change.

Congratulation! You have completed lesson 6 and 
learnt the following:

1. How to construct a circuit to run a DC motor.
2. How to control a DC motor speed.
3. How to use switch...case statement. 

3. To stop the motor from spinning, you can write either of these:

 digitalWrite (pin, LOW);
                  or
   analogWrite (pin, 0);

Click here or scan QR code to 
watch the demo video



LESSON 7
ULTRASONIC

SENSOR



Project 16: Setting Up Ultrasonic Sensor

1. Get ready these components 

2. Construct the circuit as shown below.

Breadboard Jumper wires

Ultrasonic sensor

Note: As shown in the �gure. 
Please connect the sensor at the
edge of the breadboard and 
ensure the jumpers are not 
blocking the sensor.  

Ground (-)    Pin 12    Pin 11    5V (+)



3. Write these codes then upload to your board. 

4. Once done uploading, click the serial monitor icon to view the
     result. You can place an object in front of the sensor. Try to 
     adjust the distance between the object and the sensor 
     to see the di�erence. 



https://youtu.be/Dg_RYgUXytA

5. Check your result.

How it works

De�ne “duration” as a long variable.
De�ne “distance” as a integer.

Set pin 11 (the trig pin) to low
Delay 2 microseconds
Set pin 11 to high
Delay 10 microseconds
Set pin 11 to low again

Check the pulse’s duration at pin 12 (the echo 
pin). Put that value into “duration”.
Then convert that value into distance in cm

Print “Distance =” at serial monitor
Print the distance value then follow by “cm”

Click here or scan QR code to 
watch the demo video



          
             

           

Setup serial communication

6. We are going to group these codes into a self-declare function
     call “ultrasonic” because these are the same codes you need to 
     write everytime you want to use the ultrasonic sensor. So that we 
     can just call the function everytime we want to use it.

Modify your previous program into this then upload to your board.



Good To Know

Ultrasonic Sensor
The baic idea of how an ultrasonic sensor works is simple. The sensor 
transmits ultrasound to the air and it will be bounced back if an object or 
obstacle is blocking its way. Measuring the duration needed for the 
ultrasound to transmit and receive, we are able to estimate the distance of 
the object from the sensor.  

Ultrasonic sensor is widely used at our car’s rear bumper to help the drivers
to detect objects that cannot be seen. The advatage of an ultrasonic sensor
over the infrared sensor is its insensitiveness to the surrounding lighting. it
still can work under sunlight and in the darkness. 

If you would like to learn more on how the distance is calculated, you can 
watch this video: https://www.youtube.com/watch?v=ZejQOX69K5M  

7. Check your result again, you should be able to get the same result.



Arduino Function
1. You can use this function to read the time cycle of a pulse.
          pulseIn (pin, value)
                pin: the number of the pin on which you want to read the pulse.
                value: type of pulse to read: either HIGH or LOW.

2. Data type
     You may ask why most of the time we are using “int” to de�ne a 
     variable but in this project we are using “long”. This is because we need 
     to inform Arduino what kind of number we want to store at the variable,
     whether it is a small number, large number, a number with decimal
     points, and etc. In this project, the number we need to store for
     “duration” is large. 

  
Variable 

char

int

long

�oat

Number Range
-127  to  128

-32,768 to 32,767

-2,147,483,648 to 2,147,483,647

decimal numbers



Project 17: Build A Car’s Rear Bumper Sensor

1. We are going to make the piezo buzzer to beep according to the 
    distance sensed by the sensor. The buzzer beeps slower when the 
    object is far from the sensor and it beeps faster when the object get 
    closer just like our car’s bumper sensor. Write these codes then 
    upload to your board. 



https://youtu.be/kzqOK-KHn-k

2. Check your result.

How it works

Set pin 8 (piezo buzzer) as output.

Call the ultrasonic function.

if distance is less than 2cm,
buzzer will beep continuously with note F4

Else, buzzer will beep with note F4 

at the speed of “distance x 10”.
eg: if distance = 5cm, beep speed 50ms
        if distance = 10cm, beep speed 100ms

Click here or scan QR code to 
watch the demo video



https://youtu.be/K6KbEnGnymk https://youtu.be/778e27mzYl0

Challenge

Q: Build a Theremin using your Maker UNO and the ultrasonic sensor. 
     Theremin is an electronic musical instrument that can be controlled 
     without physical contact by the thereminist (the performer). With the 
     ultrasonic sensor, we are able to divide the ultrasonic sensor’s sensing
     range into a few zones that playing di�erent tones. 
      

Congratulation! You have completed lesson 7 and 
learnt the following:

1. How an ultrasonic sensor works.
2. How to create self-declare functions. 

Click here or scan QR code to 
watch the demo video


